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Planning and Managing a 
Vantage Database
This guide lists Vantage database requirements and explains how to install and manage 
the Vantage Database.

Installing a database in preparation for Vantage is easiest when you plan carefully, and 
you have a working knowledge of Windows server administration, Microsoft SQL 
Server, and installation and configuration of enterprise-level software. Consult your IT 
group for assistance as necessary.

Note: Go to www.telestream.net/telestream-support/vantage/support.htm to 
browse the Vantage Web library, user guides, patches, application notes, and other 
documents.

The following topics provide information for planning, installing, and maintaining a 
Vantage database:

■ Operating System Requirements

■ Database Server Requirements for SQL Standard

■ Database Selection and Configuration Guidelines

■ Installing MS SQL Server

■ Installing the Vantage Database

■ Backing Up and Restoring the Vantage Database

■ Shrinking a Full Database

■ Moving the Vantage Domain Database to Another Database

http://www.telestream.net/telestream-support/vantage/support.htm
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Operating System Requirements
The Vantage Domain Database and the MS SQL Server for Vantage should be installed 
and operated only on the following operating systems (64-bit only):

• Windows Server 2012 R1 or R2

• Windows Server 2016 Standard or Data Center Edition

Database Server Requirements for SQL Standard
The following recommendations are for customers running SQL Standard. To 
determine which version of SQL to use, please refer to the Guidelines for Selecting SQL 
Express or SQL Standard.

Telestream recommends using “per core” SQL Standard licensing when using Vantage. 
In this licensing scenario, all physical cores on the server (or virtual machine) must be 
licensed. Please contact your IT department or Microsoft for more information about 
SQL Standard licensing options. For Microsoft’s discussion of licensing by cores, refer to 
this URL: http://www.microsoft.com/licensing/about-licensing/briefs/licensing-by-
cores.aspx.

Telestream recommends the following hardware for dedicated database servers:

SQL Standard: 4-Core Server Minimum Recommendations

Component Specification

CPU 64-bit, 4 physical cores, 8 MB cache, 3.0 GHz or greater. For 
example, Intel E3-1230 v2.

RAM 16 GB DDR minimum required, 32 GB or more recommended 
for high job volumes; 1600 MHz recommended

OS/Software HDD RAID-1, 2 drive volume, minimum 7200 RPM, SSD preferred

Database HDD RAID-5, 3 drive volume, minimum 250 GB per drive, 7200 RPM

Network Dual 1 GbE or greater NICs

Operating System Windows Server 2012 (R2 recommended for best performance) 
or Windows Server 2016

http://www.microsoft.com/licensing/about-licensing/briefs/licensing-by-cores.aspx
http://www.microsoft.com/licensing/about-licensing/briefs/licensing-by-cores.aspx
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SQL Standard: 8-Core Server Minimum Recommendations

Component Specification

CPU 64-bit, 8 physical core processors, 2.0 GHz or greater. For 
example, Intel ES-2640 v2.

RAM 24 GB DDR minimum required, 32 GB or more recommended 
for high job volumes; 1600 MHz recommended

OS/Software HDD RAID-1, 2 drive volume, minimum 7200 RPM, SSD preferred

Database HDD RAID‐5, 3 drive volume, minimum 250 GB per drive, 7200 
RPM

Network Dual 1 GbE or greater NICs

Operating System Windows Server 2012 (R2 recommended for best performance) 
or Windows Server 2016

Please see the following page and table for additional guidelines.

When choosing your database server, the primary consideration is how many clients 
will access job status views simultaneously. Real-time job status views are the largest 
consumer of database CPU resources. 

The following table can guide you in selecting a server and configuring the system. 

Job Status View Clients Database Server Notes

1 or 2 clients 4-core server IIS and the Workflow Designer 
may run on the DB server.

3-8 clients 4-core server IIS and Workflow Designer must 
run on a separate server.

More than 8 clients 8-core server (or more) Contact Telestream for guidance 
if you plan to have more than 20 
clients.

Note: The recommendations above ensure sufficient CPU headroom for activities 
such as Workflow Portal operation, running large arrays, deleting jobs, etc.

For additional guidelines on database installation in a Vantage domain, see Database 
Selection and Configuration Guidelines.
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Database Selection and Configuration Guidelines
If no other Microsoft SQL database version is already installed, Vantage automatically 
installs Microsoft SQL 2016 SP1 Express. If a Microsoft SQL database is already installed, 
Vantage detects it and does not install the default Express version.

Vantage is supported on the following database systems: 

• Microsoft SQL Server 2012 Express, Standard, or Enterprise

• Microsoft SQL  Server 2014 Express, Standard, or Enterprise

• Microsoft SQL Server 2016 Express, Standard, or Enterprise

The MS SQL Server for Vantage should be installed and operated only on the following 
operating systems (64-bit recommended for performance):

• Windows Server 2012 R1 or R2

• Windows Server 2016 Standard or Data Center Edition

The following topics provide guidelines for choosing and implementing a database:

■ Guidelines for Selecting SQL Express or SQL Standard

■ Guidelines for an Array Installation with SQL Standard

■ Other Database Configurations

■ Improving Uptime with Mirroring or Availability Groups

■ Installing the Vantage Database

Note: SQL database tools must not be used to move a Vantage domain database of 
one version to a later version of Vantage. To upgrade Vantage, only use Vantage 
installers or the Vantage Database Deployment Utility.
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Guidelines for Selecting SQL Express or SQL Standard
The decision about whether to use SQL Standard or Express depends on your planned 
maximum database size and the expected average volume of database traffic. The 
following topics provide information to help you choose which database to use:

■ Comparing SQL Express and SQL Standard

■ Vantage Guidelines for SQL 2016 Express

Comparing SQL Express and SQL Standard
SQL Express and SQL Standard database limitations are compared in this table: 

SQL 2014/2016 Express SQL 2014/2016 Standard

Max. Cores: 4 Max. Cores: 16/24

Max. DB RAM: 1 GB Max. DB RAM: 64/128 GB

Database Size: 10 GB Max. Database Size: 524 PB

Microsoft offers additional information about SQL Server capabilities and limitations at 
this URL: http://msdn.microsoft.com/en-us/library/cc645993.

Vantage ships with SQL 2016 SP1 Express, which is suitable for single-node installations or 
Array installations up to four nodes. For very large installations, SQL Standard may be 
required.

Vantage Guidelines for SQL 2016 Express
Vantage installs SQL 2016 SP1 Express, which allows up to 10GB of database storage. 
Due to this storage limitation, SQL Express is not suitable for every Vantage installation.

The following guidelines indicate the maximums for using Vantage with SQL 2016 SP1 Express:

• Transcoding: SQL 2016 SP1 Express can support up to 15,000 Vantage jobs in the 
database at a time. Note: This assumes that each job contains 10 actions. More actions 
in a job require more storage, allowing fewer jobs.

• TrafficManager: SQL 2016 SP1 Express can support up to 1,500 TrafficManager 
commercials in inventory at a time.

• Vantage Array: Up to four (4) Vantage servers can simultaneously connect to SQL 
2016 SP1 Express as part of a Vantage Array. This includes any redundant or backup 
machines.

Database Shutoff Feature for SQL Express
If a Vantage single-node or Array installation using SQL Express nears the SQL Express 
database size limit, Vantage stops accepting jobs. Attempts to submit jobs manually 
launches a warning dialog indicating that the database is at or near capacity. To release 
space in the database, see the procedure in the Managing a Vantage Domain chapter: 
Shrinking a Full Database in the Vantage Domain Management Guide.

http://msdn.microsoft.com/en-us/library/cc645993
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Guidelines for an Array Installation with SQL Standard
For high traffic installations, Vantage performance improves when you use SQL 
Standard and separate the database from other services such as the operating system 
and Vantage services. The following guidelines provide increasing levels of 
performance improvement:

• Always place SQL Standard and the database on a dedicated server, separate from
Vantage services, the Vantage store, and the input and output files. This approach
provides the largest increase in performance.

• Place the Vantage database files on a dedicated physical drive or RAID array, sepa-
rate from the operating system.

Note: Installing a Vantage domain database on a separate server does not require an 
extra Vantage license for that server.

When installing a Vantage array with SQL Standard, ensure that the server hardware 
meets the requirements described in Operating System Requirements. To improve 
database availability, see Improving Uptime with Mirroring or Availability Groups. 

Recommendations for Large Arrays
For arrays containing 10 or more nodes, consider these additional recommendations: 

Feature Recommendation

Server memory for DB < 32 GB 64 GB 

Server memory for DB > 32 GB 128 GB

Cores 16 cores minimum, 24 cores recommended.

Partitioning Create a dedicated partition for SQL Server data.

SSD or hard drives SSDs may provide better performance but only in 
cases of high I/O. Use SQL to monitor I/O wait times 
and PERFMON to measure average disk I/O latency. 
Latency should be less than 0.020 seconds (20 ms).

.

Other Database Configurations
Vantage systems can work with other special database configurations:

• For a fully redundant system, you can use SQL Standard with Mirroring. This
requires professional services from Telestream with machines and licenses for two
SQL Standard databases, plus a third machine running the free SQL Express.

• Large volume systems can use SQL Enterprise.

• You can use SQL with Clustering.
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Improving Uptime with Mirroring or Availability Groups
SQL Server Availability Groups or database mirroring can prevent Vantage domain 
interruption if a single database server fails. Telestream supports mirroring for SQL 
Standard 2012 and SQL Standard 2014 and Basic Availability Groups for SQL Standard 
2016. SQL Enterprise with Clustering may also be used for high availability.

A mirrored database requires the following physical servers:

• A dedicated server to host the principal database

• A dedicated server (of similar capability to the principal database server) to host the 
mirror database

• An optional dedicated server to host the witness server.

The witness database is a lightweight service which can run effectively on a low-end 
server, but cannot be installed on a database server.

Basic Availability Groups require:

• A dedicated server to host the primary replica database

• A dedicated server (of similar capacity) to host the secondary replica database

• A reliable witness file share server.

Note: This guide does not provide instructions for installing or implementing a 
mirrored database or Availability Groups. Consult your database administrator or 
contact your Telestream representative regarding installation service options.

Note: Telestream strongly recommends using a dedicated server for the witness 
server to ensure uninterrupted operation in case of a database failover. If the witness 
server function is placed on a server with Vantage services, transcoding can consume 
too many resources and prevent timely database switchover.

Note: If a mirrored database fails over, the domain change is not reflected in Vantage 
client program title bars, which still show the original domain name. Users can correct 
this by using File > Change Vantage Domain in the clients to select the new domain.
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Installing MS SQL Server
If you are creating or upgrading a Single-Node Vantage installation, pre-installing the 
database is not necessary. The Vantage Setup installer will install MS SQL Server Express 
and the Vantage database automatically on the single-node server with the Vantage 
applications and services. 

However, if you are installing or upgrading an existing Vantage Array installation on 
multiple servers, you need to have MS SQL Server Standard (or better) installed before 
you install the Vantage product using the Vantage Setup installer. This procedure will 
guide you through the MS SQL Server Standard installation, and the procedure that 
follows (Installing the Vantage Database) will install or upgrade the Vantage database. 
After SQL Server and the Vantage database are installed, you can install the Vantage 
Array using the Vantage Setup installer.

This guide does not provide instructions for installing a mirrored database and 
implementing mirroring. Consult your database administrator or contact your 
Telestream representative regarding installation service options.To set up the Vantage 
domain database, follow these procedures in the order listed:

■ Installing SQL Server 2012 Standard

■ Installing SQL Server 2014 Standard

■ Installing SQL Server 2016 Standard

■ Installing the Vantage Database

Installing SQL Server 2012 Standard
The following procedure explains how to install SQL Server 2012 Standard. If you are 
installing SQL Server 2014 or SQL Server 2016, please skip to that topic, Installing SQL 
Server 2014 Standard or Installing SQL Server 2016 Standard.

Follow these steps to install SQL Server 2012 Standard on a server:

1. Log into the target server with a local administrator account.

2. Insert the SQL Server 2012 Standard DVD into the server’s DVD drive and start the 
installer (setup.exe) if it does not run automatically.

3. SQL Server Installation Center—Click Installation in the left column, then select 
New installation or add features to an existing installation.

4. Setup Support Rules—Click OK.

5. Product Key—Enter your product key and click Next.

6. License Terms—Accept the license terms and click Next.

7. SQL Server Updates—Click Next after updates have completed. 

8. Feature Selection—Check Database Engine Services and Management Tools, and 
click Next.
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9. Instance Configuration:

a. Select Named instance.
b. Enter VANTAGE in the Named instance field and the Instance ID field.
c. Click Next to continue.

10. Disk Space Requirements—Click Next to continue.

11. Server Configuration:

a. For SQL Server Agent, the Startup Type should be disabled. (If the Startup Type is 
set to automatic, the service must be stopped before running Vantage Setup.)

b. For Server Database Engine, select NT AUTHORITY\NETWORK SERVICE
c. Click Next to continue.

12. Database Engine Configuration:

a. Click Add Current User.
b. Select Mixed Mode.
c. Enter the Vantage sa user password (vantage12!) in the Enter Password and 

Confirm Password fields.
d. Click Next to continue.

13. Continue to click through the installer windows accepting the default settings to 
complete installation.

14. Complete—Click Close to close the SQL Server installer.

15. Select Start > SQL Server Management Studio.

16. Connect to the Vantage domain database using the following information:

Server type: Database Engine
Server name: [hostname]\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

17. In the Object Explorer panel, right-click [hostname]\VANTAGE and select Properties.

18. In the Server Properties window, go to the Memory page.

19. Set the Maximum server memory (in MB) to 75% of the system's memory. For 
example: If the system's memory is 8 GB (8192 MB), then the maximum server 
memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

20. Click OK.

21. Close the SQL Server Management Studio.

Now that SQL Server Standard is installed and configured for Vantage, install the 
Vantage domain database as explained in this topic: Installing the Vantage Domain 
Database. The Vantage installer will detect that SQL Standard is already installed, will 
not install SQL Express, and will attach to the installed instance.



Planning and Managing a Vantage Database
Installing MS SQL Server

12 
Installing SQL Server 2014 Standard
Follow these steps to install SQL Server 2014 Standard on a server (skip this topic if you 
already installed another version of SQL Server):

1. Launch setup from the SQL Server 2014 Standard installation media.

2. In the SQL Server Installation Center, go to Installation on the left.

3. Select New SQL Server Stand-alone installation or add features to an existing 
installation.

4. On the Product Key page, enter a product key and click Next.

5. Accept the license terms and click Next.

6. Click Next on the Microsoft Update page.

7. On the Setup Role page, select SQL Server Feature Installation and click Next.

8. On the Feature Selection page, enable Database Engine Services, Management Tools 
– Complete and click Next.

9. On the Instance Configuration page, select Named instance, enter VANTAGE and 
click Next.

10. On the Server Configuration page, click the cell for the account name of the SQL 
Server Database Engine service. After selecting the cell, click the drop-down list and 
select <<Browse…>>.

11. In the Enter the object name to select field, type NETWORK SERVICE and click OK. 
Then click Next on the Server Configuration page.

12. On the Database Engine Configuration page, select Mixed Mode (SQL Server 
authentication and Windows authentication). Enter vantage12! for the password and 
click the Add Current User button. 

13. (Optional) If you would like to specify a non-default location for the database files, 
go to the Database Engine Configuration page, select the Database Directories tab, 
and change the Data root directory path.

14. Click Next on the Database Engine Configuration page.

15. Click install on the Ready to Install page.

16. When installation completes, click Close and close the SQL Server Installation 
window.

17. From the Start menu, launch the SQL Server 2014 Management Studio.

18. In the Server name field, enter .\vantage as the server name.

19. Set authentication to SQL Server Authentication.

20. Enter sa for the login and vantage12! for the password.

21. In the Object Explorer panel, right click .\vantage (SQL Server 12.0.2000 – sa) and 
select Properties.

22. From the Select a page panel, go to Memory and set Maximum server memory (in 
MB) to 75% of the host system’s memory. For example, if the system's memory is 8 
GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB 
(6144 MB) (8192 x 0.75 = 6144).
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23. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the 
Vantage domain database as explained in this topic: Installing the Vantage Domain 
Database. The Vantage installer will detect that SQL Standard is already installed, will 
not install SQL Express, and will attach to the installed instance.

Installing SQL Server 2016 Standard
Follow these steps to install SQL Server 2016 SP1 Standard on a server (skip this topic if 
you have already installed SQL Server 2016 SP1 Standard):

1. Launch setup from the SQL Server 2016 Standard installation media.

2. In the SQL Server Installation Center, select Installation on the left.

3. Select New SQL Server Stand-alone installation or add features to an existing 
installation.

4. On the Product Key page, enter a product key and click Next.

5. Accept the license terms and click Next.

6. Click Next on the Microsoft Update page and the Install Rules page.

7. On the Feature Selection page, click Feature Selection on the left, enable Database 
Engine Services and click Next. 

8. On the Instance Configuration page, select Named instance, enter VANTAGE and 
click Next.

9. Click the cell where the SQL Server Database Engine Row and Account Name 
column intersect. After selecting the cell, click the drop-down list and select 
<<Browse…>>. 

10. In the Enter the object name to select field, type NETWORK SERVICE and click OK. 
Then click Next on the Server Configuration page. 

11. On the Database Engine Configuration page, select Mixed Mode (SQL Server 
authentication and Windows authentication). Enter vantage12! for the password and 
click the Add Current User button. 

12. (Optional) If you would like to specify a non-default location for the database files, 
go to the Database Engine Configuration page, select the Data Directories tab, and 
change the Data root directory path.

13. Click Next on the Database Engine Configuration page.

14. Click Install on the Ready to Install page.

15. When installation completes, click Close and close the SQL Server Installation 
window.

16. Install SQL Server 2016 Service Pack 1 (SP1):

https://www.microsoft.com/en-us/download/details.aspx?id=54276

Installing SQL Server 2016 Management Studio

Management Studio is not automatically installed for SQL Server 2016. To install and 
configure it, follow these steps:

https://www.microsoft.com/en-us/download/details.aspx?id=54276
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1. Browse to https://msdn.microsoft.com/en-us/library/mt238290.aspx.

2. Click the link to “Download SQL Server Management Studio.” At the time this 
document was written, version 16.5.3 was used.

3. After the download completes, launch the setup and click Install.

4. Click Close when the installation completes.

After the SQL Server 2016 Management Studio has been installed, it must be used to 
set the maximum limit for SQL Server's memory consumption:

1. From the Start menu, launch the SQL Server 2016 Management Studio.

2. Connect to the instance using SQL Server Authentication:

Server name: .\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

3. Right-click the hostname at the top of the Object Explorer tree and select 
Properties.

4. From the Select a page panel, go to Memory and set Maximum server memory (in 
MB) to 75% of the host system’s memory. For example, if the system's memory is 8 
GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB 
(6144 MB) (8192 x 0.75 = 6144).

5. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the 
Vantage domain database as explained in this topic: Installing the Vantage Domain 
Database. The Vantage installer will detect that SQL Standard is already installed, will 
not install SQL Express, and will attach to the installed instance.

https://msdn.microsoft.com/en-us/library/mt238290.aspx
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Installing the Vantage Database 
If you have already installed MS SQL Server 2012, 2014, or 2016 the Vantage Installer allows 
you to install or upgrade a current Vantage database in the existing SQL installation. You 
can install in any of these MS SQL database versions:

• SQL Express

• SQL Standard, SQL Standard with Mirroring, SQL Standard with Clustering

• SQL Enterprise and SQL Enterprise with Clustering

Before you begin, follow the prerequisite procedure below.

Prerequisites for Instance Installation
It is assumed you have already created a SQL database instance into which a Vantage 
database instance can be deployed. The database instance must meet certain 
prerequisites before you can use the Vantage utility to deploy a Vantage database 
instance:

• The SQL instance must be deployed as a named instance.

• The SQL instance must include a SQL or active directory user account. The user can 
be sa or another account, and any password may be used.

The user account installing the Vantage database must have the sysadmin role 
assigned. The steps below explain how to assign a role.

• The user account running the Vantage database after it is installed can have the 
db_owner and dbcreator roles assigned instead of sysadmin, if you prefer the user to 
have lower privileges.
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Configuring the Administrator Role
1. In the SQL Server Management Studio > Object Explorer panel, expand Security, 

and expand Logins.

2. Right-click the sa user or another user that you want to use as the administrator 
login, and select Properties.

3. Go to Server Roles and enable public and sysadmin. Click OK. This gives the user 
system administrator privileges for the database instance.
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Configuring the Vantage User Role
1. Right-click the current Windows user and select Properties. 

2. Click User Mapping. Check master or Vantage (if present) in the database column, 
and check db_owner. Click OK. 

3. Right-click the Windows user and select Properties again.

4. Click Server Roles and check dbcreator to enable it. Click OK. This gives the current 
Windows user sufficient privileges to run the Vantage database instance after 
installation.
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5. From the Select a page panel, go to Memory and set Maximum server memory (in 
MB) to 75% of the host system’s memory. For example, if the system's memory is 8 
GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB 
(6144 MB) (8192 x 0.75 = 6144).

6. Click OK to close the Microsoft SQL Server Management Studio window.

Installing the Vantage Domain Database
This task installs a clean new Vantage domain database instance into the previously 
installed SQL database. Follow these steps:

1. Log into the database server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or 
systems, you must turn off Windows Firewall.

2. Stop the SQL Server Agent Service in Start > Services, if it is running. 

3. Run the Vantage_8.0.exe file and click Install to extract and run the Vantage 
_8.0_Setup installer. 

4. When the Welcome dialog appears, click Next to display the license agreement. 

5. License Agreement—Click I Accept if you agree to the license terms, and then click 
Next.

6. Select Array {Multi-Node} Installation and click Next.

7. Select Custom Install and deselect all check boxes to install only the Vantage 
database. Then click Next.

8. When Ready to Install appears, click Install to begin installation, which takes a few 
minutes. Progress is displayed as the installation takes place.

Note: The Vantage Setup program checks for an existing SQL Server installation, and 
if found, Setup skips the installation of SQL Server. If SQL Server is not found, SQL 
Server 2016 SP1 Express will be installed. Similarly, if no Vantage database is found, a 
new one is installed. If a Vantage database is found, it is upgraded; upgrading 
preserves workflows, design items, job history, catalogs, stores, application 
configurations, user settings and licenses.

9. Click Next when the installer indicates it is finished. 

10. The installer displays Installation was successful! (or indicates errors if unsuccessful). 
Click Done to close the installer application. Database installation is complete.
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11. Launch the SQL Server Management Studio.

12. Connect to the instance using SQL Server Authentication:

Server name: .\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

13. Right-click the hostname at the top of the Object Explorer tree and select 
Properties.

14. Go to Memory on the left and set “Maximum server memory (in MB)” to 75% of the 
server’s memory. Click OK.

15. You are now ready to install or upgrade Vantage:

Note: For detailed Vantage installation instructions, please refer to the Vantage 
Installation Guide, available as a standalone guide and also included in the Vantage 
Domain Management Guide.

a. New Vantage Installations: If you are installing a new Vantage instance, run the 
Vantage_8.0_Setup.exe installer again (extracted to the C:\Vantage8.0 folder 
when you ran the Vantage_8.0.exe archive file), select Array {Multi-Node} 
Installation, select Custom, select the components you want, but do NOT select 
Database. This ensures Vantage installs, but the database is not touched.

b. Upgrading Vantage: If you are upgrading an existing Vantage instance, use the 
Control Panel Programs and Features to remove only Vantage but leave MS SQL 
and the domain database in place. Then run the Vantage_8.0_Setup.exe installer 
(extracted to the C:\Vantage8.0 folder when you ran the Vantage_8.0.exe archive 
file), select Array {Multi-Node} Installation, select Custom, select the components 
you want, but do NOT select Database. This ensures Vantage installs, but the 
upgraded database is not touched.
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16. After Vantage installation, use the Vantage Management Console > File > Change 
Vantage Domain (shown below) to find and connect your Vantage installation to 
the deployed database. Use the Search button to populate the list. 

If you installed a Vantage database with a custom name and password, you may 
need to select Specify Vantage Domain name/IP Address. Then enter the server 
name, the custom database name, expand the Connection settings, and enter the 
custom Login and Password. When you click OK, the Vantage Management Console 
should connect to the database and begin normal operation. 

REMINDER: If you use Windows authentication, you must also set the SQL Server 
service Log On to the same Windows account that you will use for database 
authentication. To change the SQL Server service Log On, select Start > Administra-
tive Tools > Services > SQL Server > Properties > Log On > This account. 

17. If necessary (for a new installation), install Vantage licenses using the Vantage 
Management Console > Licenses panel and configure Vantage as described in the 
Vantage Domain Management Guide. 

18. If you have deployed a new database or replaced an existing database with a new 
one, the domain will not have any ComponentPacs installed. When you run the 
Vantage Setup installer to install Vantage components and services after deploying 
the database, the major ComponentPacs will be installed. If you do not run the 
Vantage Setup installer after database deployment on the database server, or if you 
wish to install additional ComponentPacs, use the Vantage Management Console > 
ComponentPac Management feature to install the ComponentPacs.

19. Lastly, if you assigned the Vantage services to the host name of the database server 
before using the Database Deployment Utility, use the Microsoft Services Console 
to restart the Vantage services after the database is deployed. Also close and 
reopen the Vantage Management Console and Workflow Designer. These 
operations prevent a situation where Vantage action templates and fulfillment 
schemes do not deploy properly.
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Database Maintenance Topics
The topics covered in the remainder of this guide explain how to perform typical 
database maintenance procedures:

■ Backing Up and Restoring the Vantage Database

■ Shrinking a Full Database

■ Moving the Vantage Domain Database to Another Database
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Backing Up and Restoring the Vantage Database
The Domain Backup feature allows you to save archival copies of the Vantage domain 
database in a separate file. The Domain Restore feature allows you to replace your 
current Vantage domain database with the contents of a previously-backed up domain. 
The domain backup and restore features are primarily used for the following:

• Returning the database to a previously backed-up state.

• Preparation for database mirroring.

Note: The domain backup and restore features are not designed for use during 
Vantage upgrades. If you back up the database from a specific version of Vantage, that 
backup can only be restored to the same Vantage software version. During a Vantage 
upgrade, the Vantage installers manage any required database updates as described 
in Upgrading from a Previous Version in the Vantage Installation Guide or the Vantage 
Domain Management Guide.

The following topics describe domain backup and restore:

■ Understanding Domain Backup and Restore

■ Backing Up the Domain

■ Restoring the Domain

Understanding Domain Backup and Restore
During a domain backup, Vantage creates a single backup file that contains all 
workflows, all services, and all jobs registered in the domain. It is important to 
remember that the backup file contents reflect the domain contents as of the moment 
the backup file is created. To capture changes made after a backup, you must create 
another backup.

When you restore a domain, all services are stopped, the current database contents are 
irretrievably destroyed, and the backup file you specify is used to create the 
replacement database. The services defined in the backup file are started and the 
Vantage domain database repopulates with the backup database values.

Because the restore feature irretrievably destroys the contents of the current database, 
Telestream recommends that you back up the current database before restoring a 
previous database. Backing up the current database captures all database changes 
made since the last backup, and it gives you a backup file that you can use to restore 
the current database if necessary. 
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Backing Up the Domain
To back up the Vantage domain database, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console in the Vantage System Administration Guide or the Vantage 
Domain Management Guide.

2. In the components panel, select Domain Management.

Vantage displays the Domain Management details panel shown in this figure:

3. Verify that all services in the Active Services list are hosting 0 sessions.

Note: Although you can create a successful backup while services are executing 
workflow tasks, some job records may be lost. It is best to back up the domain when 
there is no activity in the domain.

4. Click the Backup... button.

5. In the Save the domain dialog, browse to the folder where you want to store the 
backup file, and click Save.

6. When the Backup Complete message appears, click OK.
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Restoring the Domain

CAUTION: Telestream recommends that you restore a Vantage domain using the 
same machine that created the backup file. If you restore the domain from another 
machine, the services defined in the database must match the services installed on 
the other machine.

To restore a Vantage domain database, do the following:

1. Start the Vantage Management Console as described in Starting the Vantage 
Management Console in the Vantage System Administration Guide or the Vantage 
Domain Management Guide.

2. In the components panel, select Domain Management.

Vantage displays the Domain Management panel shown in the previous figure.

3. To provide the option to return to the current Vantage domain database later, back 
up the current domain database as described in Backing Up the Domain.

CAUTION: Always back up your current database before restoring it to an earlier 
backup. Restoring your Vantage domain database overwrites the entire contents of 
the current database with the contents of the backup file selected.

4. Verify that all services in the Active Services list are hosting 0 sessions.

Note: When you restore a domain, all services are stopped, and all information 
related to any jobs in progress is lost. The restored database contains only the domain 
information captured when the domain was backed up.

5. Click the Restore... button, read the information dialog that appears, and click OK.

6. In the Load the domain dialog, browse to the backup file you want to restore, select 
the backup file, and click Open.

7. When the Restore Complete message appears, click OK.
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Shrinking a Full Database
If a Vantage installation using SQL Express nears the SQL Express database size limit, Vantage 
stops accepting jobs. Attempts to submit jobs manually launches a warning dialog indicating 
that the database is at or near capacity. 

You may be able to resolve this issue using the Vantage Shrink Database feature, which 
applies the MS SQL DBCC SHRINKDATABASE command to the existing database to delete 
unused entries and reduce file size. The shrink process may take some time and may slow 
database performance, so it should be done only when the Vantage system is not busy.

Use this procedure to shrink the database:

1. Start the Vantage Management Console.

2. In the components panel, select Domain Management.

Vantage displays the Domain Management details panel (see the preceding figure).

3. To protect against potential data loss, use the Backup... button to back up the 
current domain database as described in Backing Up the Domain.

4. Click the Shrink button to shrink the database. 

A dialog pops up to explain that the Shrink command may affect database perfor-
mance and should be done only when Vantage is not busy.

A Status message indicates progress.

Current Size displays the database size next to the button, so you can see any 
changes immediately upon completion of the shrink command. 

Multiple presses of the button may shrink the database additionally each time. 
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Moving the Vantage Domain Database to Another 
Database

You might want to move the Vantage domain database because:

• You are upgrading SQL Server from Express to Standard

• You are upgrading SQL Server from an older version to a newer one

• You are moving the database from one server to another

Note: If you are moving the database in conjunction with a Vantage upgrade, you 
should complete the upgrade prior to moving the database.

Note: This guide does not provide instructions for moving a mirrored database. 
Consult your database administrator or contact your Telestream representative 
regarding installation service options.

To move a Vantage domain database, follow the procedures in the following topics in 
the sequence presented:

1. Preparing for the Move

2. Backing up the Existing Database

3. Removing the Vantage Domain Database

4. Removing Microsoft SQL Server

5. Installing SQL Server Standard

6. Installing the Vantage Domain Database

7. Restoring the Vantage Domain Database Backup

8. Finishing the Move

Note: This procedure backs up the database, moves the database to a different 
SQL Server version and/or server, and restores the database. Vantage does not 
support a Vantage restore from a version 3 Vantage database to a version 4 domain.
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Preparing for the Move
If you are upgrading SQL Server, it is recommended that you back up the Vantage 
domain database, but it is not required. However, if you are moving the Vantage 
domain database to a new server, you must backup the database, as the backup file will 
be used to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the 
new database later, follow these steps:

1. Use Vantage Workflow Designer to deactivate all active workflows to prevent new 
jobs from starting.

2. Use the Job Status Views tab in Vantage Workflow Designer, the Vantage Job Status 
Views web application, or Vantage Dashboard to either determine when all jobs are 
complete or stop any jobs in process or in waiting.

3. If you are moving the database to another server, do the following:

a. Take note of any Storage, Variables, and/or Qualification Rules settings for each 
service. (In the Vantage Management Console, select Services. In the service 
panel, click each service and check the tabs at the bottom of the window.)

When you move the Vantage domain database from one server to another, the 
Storage, Variable, and Qualification rule configuration for each service is lost. 
Write down any configuration that you want to transfer to the new server.

Note: The service Storage, Variable, and Qualification Rule configuration is not lost 
when you change the SQL Server version on a server. Skip to Step 4 if you are not 
moving the Vantage domain database to a different server.

b. In the Vantage Management Console, remove all services from the Vantage 
domain as described in Removing a Service from the Domain in the Vantage 
Domain Management Guide.

Note: The default Vantage user account is Administrator with no password. This 
account has administrative privileges.

c. In the Vantage Management Console, select Licenses in the components panel.
d. On the Licenses tab, select all licenses and click the Delete button .

Note: To add the licenses back a the end of this procedure, you will need access to the 
license files. If you do not know where these files are, locate them now before you 
delete them from the existing database.

4. If you are changing the Microsoft SQL version on a server (and not moving the 
database to another server), place all services in Maintenance Mode as described in 
Entering and Exiting Service Maintenance Mode.
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Backing up the Existing Database
If you are upgrading SQL Server, it is recommended that you back up the Vantage 
domain database. If you are moving the Vantage domain database to a new server, you 
must backup the database, as the backup file will be used to restore the domain on the 
new server.

To back up the existing Vantage domain database so that it can be transferred to the 
new database later, follow these steps:

1. In the Vantage Management Console, select the domain you want to modify, select 
Domain Management in the components panel, click Backup..., and use the file 
save dialog to save the backup file to a safe location.

You will need to access the backup file to restore the Vantage domain database 
after you move it. For more information, see Backing Up the Domain.

2. Close all Vantage clients, including Vantage Workflow Designer, Vantage Web 
Applications, Vantage Workflow Portal, and Vantage Management Console.

Removing the Vantage Domain Database
The Vantage Domain Database may or may not be present as a separate entry in the 
Windows Control Panel Programs and Features window, depending on how it was 
originally installed. 

In either case, the Domain Database must be removed using one of the following 
procedures:

If the Domain Database is present in the Control Panel list, remove it as follows:

1. Log into the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

Control Panel > Programs and Features > Uninstall Programs.

3. Select Vantage Domain Database and click Remove or Uninstall.

If the Domain Database is not present in the Control Panel list, remove it as follows:

1. Log into the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

Control Panel > Programs and Features > Uninstall Programs.

3. Select Vantage and click Change.

4. Deselect the check box for Vantage Domain Database and continue with removal.
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Removing Microsoft SQL Server
When you are upgrading Microsoft SQL Server or moving the Vantage domain 
database to another server, you may want to remove the old version of SQL Server. 

To remove Microsoft SQL Server, follow these steps:

1. Log into the server with a local administrator account.

2. Open the control panel tool for removing programs:
Control Panel > Programs and Features > Uninstall Programs.

3. Select Microsoft SQL Server and click Remove or Uninstall.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, go to Start > 
Services and stop the service before clicking Retry to continue with uninstalling.

Note: If you have multiple instances (for example SQLEXPRESS and VANTAGE), you 
will need to remove them both.

4. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

Note: Uninstalling the SQL Server does not delete your Vantage workflows, resources, 
or transaction history. It leaves your domain database files intact in 
[Install_Drive]:\Program Files\Telestream\Vantage\Database. For information on 
removing the database files, see Uninstalling Vantage from a Server in the Vantage 
Installation Guide or the Vantage Domain Management Guide.

At this point, the SQL Server is removed but the database files and any Vantage services 
and clients that were installed on the server remain installed. The domain cannot 
resume operation until the SQL Server is reinstalled on this server or set up on another 
server.
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Installing SQL Server Standard
Please see Installing SQL Server 2012 Standard, Installing SQL Server 2014 Standard, or 
Installing SQL Server 2016 Standard earlier in this chapter After installing SQL, continue 
with the next topic to install the Vantage database.

Installing the Vantage Domain Database
This task installs the Vantage domain database instance. Follow these steps:

1. Log into the database server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or 
systems, you must turn off Windows Firewall.

2. Stop the SQL Server Agent Service in Start > Services, if it is running. 

3. Run the Vantage_8.0.exe file and click Install to extract and run the Vantage 
_8.0_Setup installer. 

4. When the Welcome dialog appears, click Next to display the license agreement. 

5. License Agreement—Click I Accept if you agree to the license terms, and then click 
Next.

6. Select Array {Multi-Node} Installation and click Next.

7. Select Custom Install and deselect all check boxes to install only the Vantage 
database and click Next. 

8. When Ready to Install appears, click Install to begin installation, which takes a few 
minutes. Progress is displayed as the installation takes place.

Note: The Vantage Setup program checks for an existing SQL Server installation, and 
if found, Setup skips the installation of SQL Server. If SQL Server is not found, SQL 
Server 2016 SP1 Express will be installed. Similarly, if no Vantage database is found, a 
new one is installed. If a Vantage database is found, it is upgraded; upgrading 
preserves workflows, design items, job history, catalogs, stores, application 
configurations, user settings and licenses.

9. Click Next when the installer indicates it is finished. 

10. The installer displays Installation was successful! (or indicates errors if unsuccessful). 
Click Done to close the installer application. Database installation is complete.

If you are upgrading SQL Server on the same server, the upgrade is almost complete. 
Vantage should have discovered the old database files. Now you need to finish the 
process as described in Finishing the Move. 

If the old database files are not found, or if you are installing the Vantage domain 
database on a different server, restore the database from the backup file as described in 
Restoring the Vantage Domain Database Backup.
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Restoring the Vantage Domain Database Backup
To restore the Vantage domain database using the backup file you previously created, 
follow these steps:

1. Start the Vantage Management Console on any Vantage server in the domain.

Note: If you have moved the Vantage domain database to a new server, the name of 
the Vantage domain changed to the name of the new host server. 

2. In the Vantage Management Console, select the domain to modify, select Domain 
Management in the components panel, click Restore..., and select the file to restore. 
For more information, see Backing Up the Domain in the Vantage System 
Administration Guide or the Vantage Domain Management Guide.

Finishing the Move
To finish the move, you must enable the services you disabled when preparing for the 
move. If you moved the Vantage domain database to another server, you must also 
install Vantage licenses. To return Vantage to operation, follow these steps:

1. If you changed the Microsoft SQL version on a server (and did not move the 
database to another server), do the following:

a. Remove all services from Maintenance Mode as described in Entering and Exiting 
Service Maintenance Mode in the Vantage System Administration Guide or the 
Vantage Domain Management Guide.

b. Skip to Step 4.

2. If you moved the Vantage domain database to a different server, activate Vantage 
Domain licenses as follows:

a. In the Vantage Management Console, open the domain you want to modify, and 
select Licenses in the components panel.

b. On the Licenses tab, click the Add License button  and use the open file dialog 
to select the license file.

If your domain has multiple license files (for multiple features), repeat this step 
for additional licenses.

3. If you moved the database to another server, update the configuration of services 
as follows:

a. In the Vantage Management Console, open the domain you want to modify, and 
select Services in the components panel.

b. In the Services panel, click the Add Service button  and use the dialog to select 
a service to add.

c. If any Storage, Variables, and/or Qualification Rules settings were configured for 
the service, add them now.

d. Repeat this step for each service until all services are updated.

4. Use Vantage Workflow Designer to reactivate all workflows.
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